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Project Window
The Project Window is your entry point into

PatternSmith.  It lets you manage your

patterns and drag and drop copies to the

cutting table (Nesting View).  Move copies

freely, or nest without overlaps.  You have

four easy techniques to speed your nesting,

all the way to fully automatic.  After the

patterns have been arranged on the cutting

table, they are ready to plot or cut. 
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Opening PatternSmith 2003

Open PatternSmith 2003 by double-clicking the PatternSmith
icon on your desktop.  If you do not find a PatternSmith icon
on your desktop, from the Start menu, select: Programs >
Autometrix > PatternSmith 2003.

When you open a file, the Project Window is split horizontally
into the Pattern View and the Nesting View.  The Project
Window has a menu bar at the top, a status bar at the bottom,
and eight dockable toolbars.  You can position (dock) the
toolbars along the top, bottom or sides of the screen, or let
them float freely on the Project Window.  

Pattern View

Nesting View
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Main Toolbar
The Main Toolbar allows you to open existing files, import
existing patterns from other files, create new files, and copy
patterns from one file to another. 

Opening Files
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New: Creates a new project
Open:  Opens an existing project
Save:  Saves the current project
Import:  Adds patterns from various file formats
Cut:  Removes selected patterns to clipboard
Copy:  Copies selected patterns to clipboard
Paste:  Adds copies on the clipboard to current project
Print:  Prints the active view, pattern or nesting
Selector:  Selects, moves, rotates selected patterns, copies
Undo:  
Redo:
Zoom Full Screen:
Zoom Tool:

From the Main Toolbar, choose the File Open button.
Navigate to the folder containing the file you want to open.
Select the file type in the box at the bottom of the dialog
box.  Double-click on the correct file.



To Open a File in the Project Window
1. Select the File Open tool button from the Main Toolbar.  The
Open dialog box will appear.

2. Locate Tutorial1.pat to open. Unless you changed the location
of PatternSmith during installation, it will be in the
C:\ProgramFiles\Autometrix\PatternSmith 2003\Tutorials
folder.

3. Highlight Tutorial1.pat and select Open. The patterns in
Tutorial1.pat will appear in the Pattern View of the Project
Window.

Notice that the patterns are shown in the top portion, the
Pattern View.  You will be placing copies of these patterns on
the material shown in the bottom portion of the screen, the
Nesting View. 
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Importing Files
You can bring patterns from other files into any new or open
file.  When you import files, you are bringing in the patterns,
not the nested copies.  PatternSmith can import Dxf, AAMA,
HPGL, Gerber Cut files, and Native formats.  You can also read
and open files from earlier versions of PatternSmith. 

To Import a Native file
1. Click on the File Import tool. The Import dialog box appears.
2. Go to folder: C:\Program Files\Autometrix\PatternSmith

2003\Tutorials.
3. Select Native(*.ntv) in the ‘Files of type’ combo box. 
4. Double-click on Tutorial1.ntv.  The new patterns shown below

are now added in your Pattern View.
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From the Main Toolbar, choose the File Import button.
Navigate to the folder containing the file you want to open.
Select the file type in the box at the bottom of the dialog
box.  Double-click on the correct file.



Exporting Files
PatternSmith 2003 allows you to export in the following file
formats: 

DXF file (*.dxf)
(The DXF export function exports each pattern as a 
block and an insert.)

AAMA file (*.aam)
Marker file (*.mkr)
Native file (*.ntv)

Copy and Paste
The Copy and Paste buttons allow you to move patterns from
one project to another.  Experiment by creating a new project,
and then copy and paste some of the patterns to the new
project. Use the Window menu to move between projects.

Using the Selector in the Pattern View
The Selector tool is used in the Project Window’s Pattern and
Nesting Views to select, move and rotate either patterns or
copies, as well as to drag and drop copies from the Pattern
View to the Nesting View.  Patterns or copies must be selected
in order for any tools to operate on them.
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From the File drop-down menu, choose the File Export
option.  Navigate to the folder containing the file you want
to export.  Select the file type in the box at the bottom of the
dialog box.  Double-click on the correct file.



To Use the Selector
The pattern set on the right contains the pattern pieces for a car seat
cover.  For clarity, the patterns have been arranged as the seats
would be assembled.  The pattern set on the left contains the basic
pieces from the same seat cover, now arranged randomly.  In this
exercise you will use the Selector Tool and the Rotation Toolbar to
arrange the patterns on the left to look like the pattern set on the
right.

1. Click the left mouse button on the Selector tool
2. Position the cursor over the pattern L1P12. The name of the

pattern will be shown on the Status bar and on the Pattern Tool 
Tips Window that will appear while the cursor is over the
pattern. 
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Selecting objects
Select (highlight) a pattern or copy by clicking inside its
perimeter with the left mouse button.  To select multiple
patterns or copies, hold the shift key while you continue
selecting.  Alternatively, you can click and drag a selection
box (marquee) around a group of patterns to select all
patterns enclosed by the box.  Selected patterns show a
selection point (hollow box) at their center.

Move a Pattern or Copy 
Click and hold the left mouse button inside a selected
pattern, and the entire selection will move with the mouse.

Rotate a Pattern or Copy
To rotate a pattern or copy, click and hold the right mouse
button inside any selected pattern, and move the mouse
from side to side.  Rotating a pattern does not affect copies
of that pattern.



3. With the cursor still over L1P12, click and hold the left mouse
button.  Drag the pattern toward the upper left-hand corner of
the Pattern View.

4. Now, click and hold the right mouse button, while you move
the mouse from side to side.  The cursor will change to indicate
rotation, and the pattern will rotate.

5. Rotate the pattern 90°, with the two small boxes located at the
top.

Now that you have moved and rotated one of the patterns, go
ahead and move the rest of the patterns in the left pattern set to
match the patterns in the right pattern set. You can make this
easier by also using the Rotation toolbar explained below.
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Using the Rotation Toolbar
The Rotation toolbar lets you to rotate and flip patterns. 

Rotation by Degrees
These tools let you rotate a pattern by a preset number of
degrees.

Incremental Rotate
This tool allows you to rotate a pattern by the number of
degrees you specify.
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Zero: Rotates to alignment set in Editor
+45: Rotates pattern 45 degrees counterclockwise
-45: Rotates pattern 45 degrees clockwise
+90: Rotates patten 90 degrees counterclockwise
-90: Rotates pattern 90 degrees clockwise
180: Rotates pattern 180 degrees
Incremental Rotate:  Rotates pattern specified angle
Flip Horizontal:  Inverts the pattern horizontally
Flip vertical:  Inverts the pattern vertically
Align by Element:  Aligns pattern to make element horizontal

Select a pattern or group of patterns, and then click a
rotation button.  For the 0 to 180 degree buttons, the
pattern will rotate by the number of degrees specified on the
button.  The pattern will rotate in the direction indicated on
the rotation button.



Invert Horizontal and Invert Vertical
These tools are available in the Pattern View and Nesting View
and can be used to flip selected patterns or copies horizontally
or vertically.  Flipping a copy in the Nesting View does not
affect that copy’s pattern.

Once you have finished rotating and moving the patterns into
place, your screen should look like this:
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Select the pattern(s) you want to rotate and click the
Incremental Rotate button.  Enter the number of degrees
you want the pattern to rotate and press Rotate.  If you do
not want to view this dialog box each time you use the tool,
deselect the “Display Preset with” command.  When you
want to view the dialog box to reset the number of degrees,
click the right mouse button on the Incremental Rotate
button and check the “Display Preset with” command.

Select the pattern(s) or copy you want to flip.  Click the
Invert Horizontal or Invert Vertical button.



You will notice that you are missing all of the mirrored
patterns. To create those patterns you will duplicate, flip,
rotate, and move existing patterns. 

Using the Group Toolbar

Duplicate
The Duplicate function makes a copy of the selected pattern(s).
You can enter the distance you want to offset the copy from the
original pattern.
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Duplicate:  Copies selected patterns
Combine:  Combines selected patterns into one
Group:  Groups selected patterns
UnGroup:  Ungroups selected patterns

Select the pattern(s) you want to duplicate, and click the
duplicate button on the Group Toolbar.  Enter Delta X and
DeltaY for the distance from the pattern to its copy, and
click the Duplicate button.



To Create a Mirrored Copy of a Pattern
1. Select pattern L1P11.

2. Click the Duplicate button on the Group Toolbar.
3. Enter –15. For DeltaX and –15. for DeltaY.  Press the Duplicate

button.
4. Click the Invert Horizontal button to flip the pattern.

5. Using the left mouse button, drag the pattern to its correct
location.

6. Using the right mouse button, rotate the pattern to its correct
rotation angle.

7. Continue to duplicate, flip, and position the remainder of the
patterns using the rotation buttons, Incremental Rotate tool,
and the Invert Vertical/Horizontal tools.
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L1P11

Note:  When you invert a rotated pattern, you are really
flipping its image at zero degrees.  The result may not look
as you expected, but is correct.



Combine
Use this tool when you want to combine two or more patterns
into one pattern. You can use the Undo button to separate the
patterns again, or you can separate them in the Editor.

Group
The Group tool is used to temporarily group selected patterns
or copies together. This can be done in the Project Window or
the Nesting Window. It works well when you need to nest
multiple patterns that will always be cut out together. When
you bring copies of grouped patterns into the Nesting View, the
copies will not be grouped together.

Ungroup
Use the Ungroup tool to separate grouped patterns or copies.
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Select the patterns you want to combine and click the
Combine button.  A marquee will surround both patterns.

Select the patterns or copies you want to group and click the
Group button.

Select the grouped patterns or copies you want to separate
and click the Ungroup button.



Moving Pattern Copies to the Nesting View
Before leaving the Project Window, try making a copy of a
pattern.  (Making pattern copies will be covered in detail later.)

To Copy Patterns into the Nesting View
1. Using the left mouse button, click, hold, and drag a pattern

from the Pattern View to the Nesting View.
2. When in the Nesting View, release the mouse button to drop a

copy of the pattern.  The original pattern remains in the
Pattern View and a copy is now in the Nesting View.
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Click and hold the pattern you want to copy.  Drag it to the
Nesting View (bottom screen) and release the mouse
button.
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To insert a dart
1. Select the Create Dart tool.
2. Holding the Snap key down, right-click on the endpoint at the

bottom of the gap.
3. Still holding the Snap key, right-click on the startpoint at the

top of the gap.  The Create Dart dialog box appears.

4. Set the dart Depth to 7.0 inches and the Backoff offset to 2.0
inches.  Select the radio button to make your dart a Fold dart,
and set the fold to CWW (counter-clockwise).  Click OK.
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To insert a curve dart
1. Select the Create Dart tool.
2. Holding the Snap key down, right-click on one of the endpoints

where you spread your material.
3. Still holding the Snap key, right-click on the point at the other

side of the spread.  The Create Dart dialog box appears.  

4. Enter the desired dart depth and Backoff offset.  Select the
radio button to make your dart a Notch dart.  Click OK.  You
will see a point on one side of the dart.  This is a handle.
Position the cursor over the point and it changes to a crosshair.  

5. Left-click and drag the mouse.  You will see the dart bow in and
out.  Position the dart as desired.
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Dart Transfer
The Dart Transfer tool enables you to transfer a portion of a
dart to another element.  

To transfer a dart
1. Select the Dart Transfer tool.
2. With the left mouse button, select the dart and the top

horizontal line.
3. Right-click on the Rotation Point of the dart.
4. Right-click on the selected element, at a good location for the

new dart.  The Dart
Transfer dialog box
appears.

5. Enter the % of the
dart to transfer and
the Backoff for the
new Dart.  Click OK.
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Using the Dart Transfer tool, select the dart you want to
modify and the element to which you want the dart
transferred.  Right-click on the dart rotation point and then
right-click at the desired location for the new dart.  You use
the Snap key to snap the new dart to a specific location.
The Dart Transfer dialog box appears.  Enter the amount of
the dart to transfer and the depth of the new dart.  Click
OK.



Create Pleat
The Create Pleat tool lets you insert a pleat between any two
elements on the perimeter of a pattern.

To insert a pleat
1. Bring the Front Right pattern into the Editor Window.
2. Select the Create Pleat tool.
3. Select the two perimeter elements that will be pleated.
4. Right-click at the desired Start of the pleat.
5. Right-click at the desired

End of the pleat.  The
Insert Pleat dialog box
appears.

6. Select the pleat Style and
Fold direction (counter-
clockwise or clockwise).

7. Enter the Pleat Width at
the Start and Pleat
Width at the End.
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Click the Create Pleat tool.  Select the two perimeter
elements that will be pleated.  Right-click near one of the
elements and then drag a pleat line to the other element.
The Snap key may be used to snap the pleat to existing
points.



Triangulation Toolbar
The Triangulation Toolbar enables you to create large, complex
patterns from smaller component cells.  PatternSmith uses
three types of cells: triangles, trapezoids, and curved cells.  You
can then join them into a finished pattern.  Triangulation lets
you accommodate some curvature, such as on a curved car
fender. These tools work well for a variety of covers and for seat
cushions.

Note:   For triangulation, it is easier to measure and enter
dimensions in millimeters rather than inches.  To change your
measurement units, click on Options, then Units, and then
millimeters.

Trapezoid Cell
The Trapezoid Cell tool uses six measurements to create a four-
sided cell. It will accommodate some curvature.
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Triangle: Creates a triangle cell.
AB Line: Creates a curved cell.
Trapezoid: Creates a trapezoidal cell.

Click the Trapezoid Cell on the Triangulation Toolbar.  The
Trapezoid Cell dialog box appears.  Enter the lengths of
each element.  Click OK.  To attach another trapezoid cell,
first select the element to which the new cell will be
attached.  Then create your next trapezoid cell.

PatternSmith 2003



To create a trapezoid
1. Open the Editor Window without selecting a pattern.
2. Click Options on the menu, and change Units to Millimeters.
3. Select the Trapezoid Cell on the Triangulation Toolbar. The

Trapezoid Cell dialog box appears.

4. Type in the lengths exactly as shown above and click OK. Your
first trapezoid will appear.  You will need to click the Zoom Full
Screen button to see it all.

5. Select the right vertical line and then select the Trapezoid tool
again. You will notice one of the data boxes has been grayed
out. That is the length of the line you selected. The next
trapezoid will be attached at that line.  You will also notice the
length is not exactly the same. That is because the measure-
ments are combined to give the best fit for your data.
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6. Type in the coordinates shown and click OK. You will not be
able to change the length of the grayed out box because it
represents an existing line.

Curve Cell
The Curve Cell Tool is useful for reproducing a curve. You will
be entering the distances from points along the curve to
baseline points A and B.  PatternSmith views the baseline from
its starting point.  It builds the curve cell to the right side of the
baseline.  To correctly place your curve cell, you may need to
switch the baseline’s start and end points, using the Reverse
button on the Actions toolbar.  

To create a Curve Cell
1. Select the bottom right, angled line measuring 535 millimeters.
2. Select the Reverse Button on the Actions toolbar to switch the

start and end points of the line.
3. Select the Curve Cell tool.  The Curve Cell dialog appears.
4. Enter the following distances:

Point 1: A = 138 B = 474
5. Click Next.
6. In the same way, enter the coordinates for the next two points.

Point 2: A = 253 B = 332
Point 3: A = 430 B = 115

104
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7. Click Finish.

8. In the Edit menu, click Select All.
9. Mirror this half of the pattern.  Select the Mirror tool on the

Edit toolbar.  Right-click on the left vertical line. 

To finish the pattern
1. Join the bottom curves and lines.
2. Smooth the joined elements.
3. Join and smooth the top four elements.
4. Delete the lines inside the perimeter.
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Three-Dimensional Pipe Intersecting
With PatternSmith 2003, you can create accurate two-
dimensional patterns for three-dimensional pipes or tubes,
including their intersections.  You can create intersections at
angles or at Tees.

Create Pipe Intersections at an Angle
Follow the directions below to create patterns for two intersect-
ing pipes or tubes.  You’ll begin by designing rectangular
patterns, which you will then modify through PatternSmith to
make your pipe patterns.  With PatternSmith, this potentially
complex process becomes simple!

To Create a Pipe Intersection at an angle:
1. With nothing selected in the Project View, double click to enter

the Editor Window.
2. Create a rectangle with a height equal to the circumference of

your pipe and width equal to the length of your pipe.  
Note: 
Circumference = 2 (pi) x radius OR pi x diameter
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3. Select all the sides of the rectangle (Ctrl + A) and then break all
the lines at the corners (Ctrl + B).

4. Select the side of the rectangle where the intersection will be.
5. From the main menu, click Convert>Create Pipe Intersection.

The Pipe Intersection Dialog Box appears.

6. Select Angle Change and enter the angle you want between the
pipes as they intersect.

7. The line you selected in the Editor on the rectangle is now a
reference line, and a new polyline is added reflecting the angle
of your pipe intersection.  You have now created half of your
pipe intersection.  You may duplicate (Ctrl + D) the pattern you
just created, or you can repeat the process described above if
you want the other half of the intersection to be longer or
shorter.
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Create Pipe Intersections at a Tee
Follow the directions below to create patterns for two intersect-
ing pipes or tubes.  You’ll begin by designing rectangular
patterns, which you will modify to make your pipe patterns.

To Create a Pipe Intersection at a Tee:
1. With nothing selected in the Project View, double click to enter

the Editor Window.
2. Create two rectangles - one for the Main Pipe and one for the

Intersecting Pipe, as shown on the previous page.  Create them
with heights equal to the circumferences of your pipes and
widths equal to the lengths of your pipes.  

Note: 
Circumference = 2 (pi) x radius OR pi x diameter

3. Select all the sides of the rectangle (Ctrl + A) and then break all
the lines at the corners (Ctrl + B).

4. Select the side of the rectangle where the intersection will be.
5. From the main menu, click Convert>Create Pipe Intersection.

The Pipe Intersection Dialog Box appears.
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6. Select Tee Intersection and enter the radius of your Base Pipe
(the pipe your Intersecting Pipe is intersecting).

7. The line you selected in the Editor on the rectangle is now a
reference line, and a new polyline is added reflecting the angle
of your pipe intersection.  Now you need to cut a hole in
another pipe to accomodate the intersecting pipe you just
created.   

8. In the rectangle you created for the Base Pipe, using the Create
Plot Point tool, create a plot point where you wish the intersec-
tion to take place.  The plot point will be the center of the
cutout for your intersection.  

9. With your plot point selected, go to Convert>Create Pipe
Intersection.  

10. Enter the radius of the intersecting pipe and the radius of the
base pipe.

11. Select the orientation of the base pipe.  When you are orienting
your cutout, you are simply rotating the hole.  The intersection
angle between the pipes remains at 90 degrees.  

16. Click OK.  Your patterns for intersecting pipes are finished.
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Automatic Replacement Toolbar
The Automatic Replacement Toolbar makes perfect patterns
even easier than before.  These tools are ideal for converting
Gerber cut files or digitized patterns into PatternSmith patterns
quickly and easily.  With one mouse click, polyline notches can
be converted to notch elements, corners can be broken, seam
allowances can be set, and polylines can be replaced with lines,
arcs, Beziers, and fillets.

For this section, you will need to open Tutorial14.pat, located in
the following folder:

C:\Program Files\Autometrix\PatternSmith 2003\Tutorials

The Automatic Replacement Toolbar lets you edit patterns one
element at a time by using the individual editing tools or all at
once by using the Auto Replacement Wizard.

Before you can use any of the Auto Replacement tools you need
to configure the replacement tolerance settings.
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Auto Replace Wizard
Break Notches/Corners
Move in by Seam Allowance
Rotate to Horizontal/Vertical
Line Replacement
Arc Replacement
Bezier Replacement
Fillet Replacement

PatternSmith 2003



Configuring Auto Replacement Settings
Whenever an Auto Replacement function finds a polyline that
can be replaced with a smoother line, arc, Bezier, or fillet that is
still within the tolerance you have specified, it will make the
replacement.  You can create any number of different configu-
rations for replacement, and save them by name.

To configure the tool, no elements need to be selected.  Right
click on the Wizard button to open the configuration dialog.  
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Here you can set tolerance parameters to determine how you
want PatternSmith to improve your patterns.  You cannot
change the “Default” settings, but you can create a custom
configuration by selecting “New Data” and setting new values
under each tab.  Then choose a name for the settings you’ve
chosen so that you will be able to easily use all of them again.

General
This tab lets you select which functions you want
performed automatically when you click the Wizard
button.  For this tutorial, turn off the Seams and Fillets
as shown.

Corners

You can set the minimum and maximum angle changes to
be changed to a corner (or breakpoint)  For this tutorial, set
the minimum to 20 degrees, and the maximum to 160
degrees.  

Seams
You can automatically move the elements in by any seam
allowance value.  Each configuration you create can have
a different value.

Notches

If notches are included as polylines, you can replace them
with notch elements, which can be easily moved or changed.
Make your settings as close as possible to the notches that
exist in the pattern.  You can replace them with notches the
same size as the pattern (but notch elements, easily
moveable) or with the notch that you have set as the default.
For this tutorial, set up the notches tab as shown below.
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Element Alignment
When an element is very close to horizontal or vertical,
you can have it automatically aligned to zero degrees.  It
is usually best to have the program reconnect for you by
extending or trimming.

Lines, Arcs, Bezier Curves
For each of these element types you can set the average
deviation and the maximum deviation.  For this tutorial,
set the average to .06” and the max to 0.10”  Any
polyline within those parameters will be converted to a
line, arc, or Bezier curve in that order of preference.
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Fillets
A fillet is and arc that is tangent to each of its neighbors.
Set the average deviation to 0.06” and the max to 0.10”.
The tool will attempt to fit an arc first, then a bezier
fillet.

Thinning PolyCurves
If a polyline can’t be fit with a smoother element type, it
can still be smoothed by thinning.  The resulting
polycurve will not depart from the original by more than
the deviation you set.  It is often best to set the deviation
to a conservative (low) value and do the final thinning by
hand.  For this tutorial, set the deviation to 0.03”.

To Configure the Auto Replacement Wizard
1. Double-click on the bottom right pattern to bring it into the

Editor Window.
2. Without selecting any elements, notice that the Auto Replace

Wizard button is lit on the Auto Replacement Toolbar.  Right-
click on the Wizard tool to open the Configuration dialog.  Set
all the deviation values as described above.

3. Save your Configuration as “Tutorial14”.
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To Use the Auto Replacement Wizard
1. Without selecting any alements, left-click on the Auto Replace

Wizard tool.  The Confirm Notch Locations Dialogue appears.
The Auto Replace Wizard has located all of the notches in the
pattern successfully.  If any notches were missed, you can right
click on the pattern to place a notch, and fine tune the position
in the upper left drawing area.

2. Click “Replace.”  The Auto Replace Wizard has replaced the
pattern elements with PatternSmith notches.  
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3. The Confirm Corner Locations Dialogue appears.

4. Right-click on the pattern where shown to add a corner where
the Auto Replace Wizard did not detect one.  Then, manipulate
the corner location in the smaller box in the left corner.  Snap
the circle to the point shown.  Click “Replace.”  The Auto
Replace Wizard has replaced the pattern edges with accurate
corners, as well as adding the corner you specified.  
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5. Confirm each replacement for lines, arcs, and Bezier curves.
You have an accurate, finished, PatternSmith pattern.
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Editor Menus
Some important functions are found only on the menus and are
not repeated on the toolbars.

Edit Menu

Copy to New Pattern:
This function enables you to create a new pattern based on the
shape of another pattern.  It also lets you separate patterns
from a group, such as from an imported AutoCAD drawing.
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Select the elements you will use to make the new pattern
and click “Copy to New Pattern” on the Edit menu.  A dialog
box appears.  Enter a name for your new pattern.  Indicate
whether you want the selected elements removed from the
current pattern.  Select the desired perimeter type.



Scale All/ Scale Selection:
These functions let you scale an entire pattern or selected
elements of a pattern.  Seam allowance widths do not change
when you scale elements or patterns.

Convert Menu

From the Convert menu, lines and polylines can be converted
to arcs.  Arcs and Bezier curves can be converted to lines or
polylines.  You can convert multiple selected elements at one
time.
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From the Edit menu, select Scale All or Scale Selection.
Enter the X and Y scale factors.  Indicate if you want
PatternSmith to scale the text.  Click Rescale. 



When you convert an arc or Bezier curve to a polyline, you can
determine the frequency of points along the polyline.  A low
Curve Fit Deviation produces more points than a high
deviation.  If you are not satisfied with the results of your
conversion, simply press the Undo button and try a different
Curve Deviation value.
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Select an element(s).  From the Convert menu, indicate
what element type you want your selection to become.



Transform Menu

Break Notches
In Gerber cut files, notches are included as part of a continuous
polyline.  The Break Notches function lets you separate them as
line or polyline elements.
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Select an element.  From the Transform menu, select Break
Notches.  A Break Notches Settings dialog box appears.
Enter the minimum and maximum lengths and angles that
describe your notches.  PatternSmith now recognizes these as
independent elements.



Break Corners
The Break Corners command automatically breaks a selected
polyline(s) when the angle change between polyline segments is
greater than 45 degrees.
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